
 

Meta description: The MAXREFDES100# provides a platform to evaluate Maxim’s medical 
and fitness sensors. It provides complete solutions for the Maxim’s wearable applications. 
  

MAXREFDES100# Health Sensor Platform 
 
Abstract: Maxim health sensor (hSensor) platform helps customers evaluate Maxim’s complex 

and innovative medical and high-end fitness solutions faster and easier. The hSensor platform 

supports the measurement of motion, precision skin temperature, biopotential measurements, 

and reflective photo plethysmography measurements, etc.  

The hSensor comes with a PC graphical user interface (GUI) application and Android 
application for customers to evaluate the sensors and other devices on the board.  
 
Hardware files provide complete documentation for the design. The board is also available for 
purchase. 

 
<H1>Introduction 

 

Maxim builds complex and innovative solutions for medical and high-end fitness applications. 

These solutions are primarily stemming from multiple product lines within Maxim. In order to 

help customers evaluate the features of these solutions quickly and enable them with their 

designs, Maxim developed an integrated sensor platform called “hSensor” Platform. With this 

platform, customers can evaluate our portfolio faster and more easily for multiple use cases. 



The hSensor platform is also flexible to accommodate our newer solutions in design, or on the 

roadmap. 

The hSensor platform supports the measurement of motion, precision skin temperature, and a 

variety of biopotential measurements, including electrocardiography (ECG), electromyography 

(EMG), and electroencephalography (EEG). In addition, the hSensor platform also supports a 

variety of reflective photo plethysmography measurements including pulse oximetry and heart-

rate (HR) detection at three wavelengths, 880nm (infrared, IR), 660nm (red) and 537nm (green). 

The platform supports GUI applications on Windows®-based PCs and Android®-based devices 

for simple data collection and visualization. Both direct USB connection (through a USB type C 

connector) and Bluetooth® low energy (BLE) radio are supported for configuration and data 

collections.  

A direct-to-flash memory mode is supported for data collection. Flash memory read using a USB 

connection is also implemented. 

 
The following use cases can be evaluated using this platform: 

1. Fitness Applications 

a. Chest-based applications 

 Chest straps with HR 

 Chest straps with HR & ECG 
b. Wrist-based applications 

 Smart watches with Optical HR  
c. Ear-based applications 

 Headphones with Optical HR 
2. Clinical applications 

a. Chest-based applications 

 1 lead-ECG patch for Arrhythmia detection (ECG & HR only) 

 Skin temperature measurements 
b. Finger-based applications 

 Optical SpO2 measurement 
c. Ear-based applications 

 Optical HR & SpO2  
d. Head-based applications 

 Optical HR & SpO2  
e. Arm-based applications 

 Arm bands with ECG 
 
As with all Maxim reference designs, the bill of materials (BOM), schematics, layout files, 

Gerber files, firmware, and software are all available online. 

 
 
 
 



<H1> System Diagram 
 

 
Figure 1. The MAXREFDES100# Reference Design Block Diagram. 

   <H1>Features    <H1>Applications 

 Skin temperature 

 Heart rate 

 Biopotential measurement (ECG)  

 Motion 

 Rotation 

 Barometric pressure  

 Fitness devices 

 Clinical devices 

 Wearable devices 

 

<H1> Detailed Hardware Description 

The MAX3260 microcontroller lies at the center of the hSensor. The following sensors are 

installed: MAX30003 biopotential analog front-end (AFE), MAX30205 human body temperature 

sensor, MAX30101 pulse oximeter and heart-rate sensor, LIS2DH 3-axis accelerometer, 
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LSM6DS3 3D accelerometer and 3D gyroscope, and BMP280 absolute barometric pressure 
sensor.  
  
<H2>Power Supplies 
The hSensor platform can be powered by a USB connection or by a CR2032-type coin cell 
battery. When both USB and coin cell are attached the power is drawn from the USB due to 
MOSFET / Schottky diode at Q4. If a coin cell is attached without USB the coin cell is used to 
power the hSensor platform.  
 
The hSensor platform uses a MAX14720 PMIC for the majority of the power management. The 
PMIC has internal programming such that a 3-second button press at SW1 turns the device on. 
A 10-second press at SW2 turns the PMIC off. 
 
The PMIC has a power-on configuration that provides 1.2V, 1.8V and VSYS voltages. Here 
VSYS comes from SWOUT, which in turn comes from the battery or USB through the PMIC pin 
SWIN. After power-up, the microcontroller configures the PMIC for a boost voltage of 3.3V, 
which appears at the HVOUT pin.  
 
While the PMIC provides the majority of power management there are some additional power 
supply chips. The temperature sensors are powered by a MAX8880 LDO, which is powered by 
HVOUT (3.3V) and regulates this down to 2.5V. The PMIC itself is fed by a MAX8881 3.3V LDO 
when the hSensor is attached to USB. 
 
ESD protection is provided by the MAX3205, which attaches to all of the USB signals except for 
DP/DM, which have ESD protection provided by the MAX32620. 
 
<H2> Mode selection signals 
The hSensor platform uses the USB type C connector for debug (programming) and accessory 
signals. In some circumstances, these signals would contend with a USB host, so there is 
circuity to isolate these signals as needed. 
 
The isolation is done by MAX4741 low-voltage analog switches. These switches are controlled 
by a combination of logic gates and MAX9064 single comparators.  
 
The MAX9064 has an internal comparison voltage of 0.2V and two of them are used to monitor 
the USB pins A5 and B5 (typically designated as CC/VCONN). The USB A5 and B5 pins have 
5.1kΩ pulldowns on the HSP board, a USB cable has a 56kΩ pullup on only pin A5 and a debug 
adapter board has 56kΩ pullups on both pin A5 and B5. 
 
The following table indicates how the hSensor platform self-configures based on the USB A5 
and B5 pins.  

USB 
Pin A5 

USB 
Pin B5 

Mode Connection 

Low Low Accessory VIO and UART enabled by micro 

Low High 
USB Cable All accessory signals isolated 

High Low 

High High Debug SWD, RST, VIO and UART enabled 
 
 



 
 
 
 
 
 
<H2>MAX32620 Microcontroller 

The MAX32620 is a 32-bit ARM® Cortex®-M4F (M4 plus floating point unit) microcontroller, 

suited for emerging medical and fitness applications. The architecture combines high-efficiency, 
signal-processing functionality with low cost, and ease of use. The device features 4 powerful 
and flexible power modes. Built-in dynamic clock gating and firmware controlled power gating 
minimize power consumption for any application. Multiple SPI, UART, and I2C serial interfaces, 
as well as a 1-Wire® master and USB, allow for interconnection to a wide variety of external 

sensors. A four-input, 10-bit ADC with selectable reference is provided. 

 
Refer the MAX32620 datasheet for details and design resources including evaluation kit, 
developing tools & user guides. 
   
<H2>MAX30003 Biopotential AFE 
The MAX30003 is a complete, biopotential AFE solution for wearable applications. It offers high 
performance for clinical and fitness applications, with ultra-low power for long battery life. The 
MAX30003 is a single biopotential channel providing ECG waveforms and heart-rate detection. 

 

The biopotential channel has ESD protection, EMI filtering, internal lead biasing, DC leads-off 
detection, ultra-low power leads-on detection during standby mode, and extensive calibration 
voltages for built-in self-test. Soft power-up sequencing ensures no large transients are injected 
into the electrodes. The biopotential channel also has high-input impedance, low noise, high 
CMRR, programmable gain, various low-pass and high-pass filter options, and a high resolution 
analog-to-digital converter (ADC). The biopotential channel is DC coupled, can handle large 
electrode voltage offsets, and has a fast recovery mode to quickly recover from overdrive 
conditions, such as defibrillation and electrosurgery. 

 

The MAX30003 interface is SPI/QSPI™/Micro-wire/DSP compatible. In the hSensor platform, 
the MAX30003 communicates with the MAX32620 microcontroller through an SPI bus.  

 

The MAX30003 is available in a 28-pin TQFN and 30-bump wafer-level package (WLP), 
operating over the 0°C to +70°C commercial temperature range. 

 

Refer the MAX30003 datasheet for details. 

  

<H2>MAX30205 Human Body Temperature Sensor 
The hSensor board has two MAX30205 installed, one on the top side and one on the bottom 
side.  
 

The MAX30205 temperature sensor accurately measures temperature and provides an 
overtemperature alarm/interrupt/shutdown output. This device converts the temperature 
measurements to digital form using a high-resolution, sigma-delta ADC. The accuracy of the 



MAX30205 meets the clinical thermometry specification of the ASTM E1112 when soldered on 
the final PCB. Communication is through an I2C-compatible, 2-wire serial interface. 

 

The I2C serial interface accepts standard write byte, read byte, send byte, and receive byte 
commands to read the temperature data and configure the behavior of the open-drain 
overtemperature shutdown output. 

 

The MAX30205 features three address select lines with a total of 32 available addresses. The 
sensor has a 2.7V to 3.3V supply-voltage range, low-600μA supply current, and a lockup-
protected I2C-compatible interface that make it ideal for wearable fitness and medical 
applications. 

 

In the hSensor platform, the top side MAX30205 (U2) I2C address is 0b1001-001x, the bottom 
side MAX30205 (U12) I2C address is 0b1001-000x.  

  

This device is available in an 8-pin TDFN package and operates over the 0°C to +50°C 
temperature range. 

 

Refer the MAX30205 datasheet for details.  

 

<H2>MAX30101 Pulse-Oximetry and Heart-Rate Sensor 
 
The MAX30101 is an integrated pulse-oximetry and heart-rate monitor module. It includes 
internal LEDs, photodetectors, optical elements, and low-noise electronics with ambient light 
rejection. The MAX30101 provides a complete system solution to ease the design-in process for 
mobile and wearable devices. 

  

The MAX30101 operates on a single 1.8V power supply and a separate 5.0V power supply for 
the internal LEDs. Communication is through a standard I2C-compatible interface. The module 
can be shut down through software with zero standby current, allowing the power rails to remain 
powered at all times.  
 

In the hSensor platform, the MAX30101 (U17) I2C address is 0b1010-111x.  

 
This device is available in a tiny 5.6mm x 3.3mm x 1.55mm 14-pin optical module and operates 
over the -45°C to +85°C temperature range. 
 

Refer the MAX30101 datasheet for details.  

 

<H1> Quick Start Guide for PC Application 

Download the latest MAXREFDES100# PC GUI program MAXREFDES100SWxx.zip and serial 

driver MAXREFDES100SerialDriverxx.zip (xx is the version number) located at the 

MAXREFDES100# web page.  

<H2>Required equipment: 



 MAXREFDES100# board  

 A PC with a spare USB port 

 One USB type A to C cable 

<H2>Procedure 

The MAXREFDES100# board is fully assembled and tested. Use the following steps below to 

verify proper board operation.  

1) Unzip the hSensor serial driver MAXREFDES100SerialDriverxx.zip to a local folder.  
2) Unzip the PC GUI program MAXREFDES100SWxx.zip to a local folder and run 

MAXREFDES100SWxx.exe to install the program on the PC.  
3) Run the GUI program and ignore the following pop up window. Click OK to continue.  

 

Figure 2. Connection Issue window. 

 
4) Click Cancel button on the following pop up window:  

 

Figure 3. Connection window 1. 

 
5) The GUI program should appear as follow:  



 

Figure 4. Hardware Not Connected window. 

 
6) Connect the hSensor board to the PC with the USB A to C cable.  
7) Press and hold the SW1 switch on the hSensor board for 3 seconds and then release.  

During this time, the PC looks for the device driver for the hSensor if the Maxim hSensor 
serial driver has not been installed on this computer.  

8) Open the Device Manager window, the hSensor is enumerated as MAX32620 CDC-ACM 
as shown in the following window:  



 

Figure 5. Device Manager window 1. 

 
9) Right click MAX32620 CDC-ACM and then click Update Driver Software… to finish the 

driver installation. 
10) After the driver installation is done, the hSensor is enumerated as a serial port and the 

Device Manager should display as below:  



  

Figure 6. Device Manager window 2. 

 

11) Go back to the hSensor GUI program, click Device menu, and then click Connect menu 
item, the GUI program should be connecting to the hSensor hardware. The following 
window should appear. Check the status bar, verify the hardware is connected.  



  

Figure 7. Home tab. 

12) In the future sessions, launch the GUI program by clicking the Start menu and selecting the 

Maxim Integrated folder and then selecting Health Sensor Platform software icon. This 

should bring up the connection screen. Select the right serial port number and click the 

Connect button as shown below:  

 



Figure 8. Connection window 2. 

 

 

<H1> Detailed Software Description 

The GUI program enables users to quickly configure and evaluate the sensors’ features. It also 

provide intuitive graphs for data collection and visualization. 

The File menu lets a user exit the application. 

The Device menu lets a user connect and disconnect the hSensor hardware from the GUI 

program. 

The Options menu lets a user show or hide the MAX30003 register names on the GUI, load or 

save device register settings, and enable or disable Advanced tab. 

The Logging menu lets a user log ECG, R-to-R, optical, and accelerometer sensor data in a 

CSV file format. 

The Help menu shows the program information.  

<H2> Home Tab 

The Home tab sheet (Figure 7) displays the block diagram of the hSensor platform hardware, it 

also provides quick links to navigate to other tab sheets.  

<H2> Optical Tab 

The Optical tab sheet (Figure 9) is used to configure the MAX30101 optical sensor parameters. 
It includes the sensor mode configuration, sensor ADC configurations, and LED settings. It also 
has graphs to show ADC codes and the LIS2DH accelerometer measurements. 

 



 

Figure 9. Optical tab. 

<H2> Temperature Tab 

The Temperature tab sheet (Figure 10) controls the two MAX30205 temperature sensors on 
the top and bottom sides of the hSensor board.   



 

Figure 10. Temperature tab. 

<H2> ECG Channel Tab 

The ECG Channel tab sheet (Figure 11) controls the MAX30003 ECG channel and R-to-R 
settings. 



 
Figure 11. ECG Channel tab. 

<H2> ECG MUX Tab 

The ECG MUX tab sheet (Figure 12) controls the MAX30003 input multiplexers’ settings. 



 

Figure 12. ECG MUX tab. 

<H2> Plots Tab 

The Plots tab sheet (Figure 13) displays MAX30003 ECG measurement values and input MUX 
status. 



 

Figure 13. Plots tab. 

<H2> Flash Log Tab 

The Flash Log tab sheet (Figure 14) allows users to configure data logging to flash memory. 
The Read button reads the current configured settings from flash memory and applies it to the 
UI. The Erase button clears the data-logging settings. The Write button commits the data log 
settings to flash memory by selecting the desired logging channels and parameters on this tab. 
This also clears any data values stored on the flash memory. For optical, and MAX30003 
settings, use the drop-down options on their respective tabs. The Advanced button shows the 
raw command parameters from the UI or settings read from flash memory. The Prefix and 
Suffix fields allow users to execute custom commands. The Save to File button downloads the 
data from the flash memory to one or more CSV files. The Write button and Save to File button 
operations may require a long period of time to complete depending upon the amount of data 
stored on the flash memory. 



 

Figure 14. Flash Log tab. 

<H2> Registers Tab 

The Registers tab sheet (Figure 15) lists all the registers for the MAX30101, MAX30205 (top), 
MAX30205 (bottom), MAX30003, MAX14720, and the LIS2DH. A user can directly read or write 
the registers.   



 

Figure 15. Registers tab. 

<H1> Quick Start Guide for Android Application 

The hSensor Android App is a GUI program running on an Android device. The program 

collects hSensor data and graphically displays it on the device screen. The program 

communicates with the hSensor hardware through Bluetooth 4.0 Low Energy radio.  

<H2>Required Equipment: 

 MAXREFDES100# board  

 Android device running at least version 4.4 

 Android device with Bluetooth 4.0 support 

 One CR2032 coin cell battery (optional) 

 A PC with a spare USB port (optional if battery powered) 

 One USB type A to C cable (optional if battery powered) 

<H2>Procedure  

1) Insert the CR2032 battery into the battery holder B1.  



2) If no battery is available, connect the hSensor platform hardware to a PC or Mac though a 
USB type C connector. 

3) Press and release SW1 switch on the board. The red LED beside the switch should flash.  
4) Download the latest MAXREFDES100# Android app MAXREFDES100_Android.zip 

located at the MAXREFDES100# web page. Unzip it and install it on the device. The app 
requires Android 4.4 or later. 

 

 
<<insert Fig16>> 

5) Click the MAXREFDES100 icon to start the hSensor Android App.  

  

<<insert Fig17>> 

 



6) Click the Start button at the bottom of the screen. 
7) Click the SCAN button at the top of the screen. The scan lists all of the devices currently 

advertising using Bluetooth 4.0. 
8) Click the MAX32610 HSP+J device in the list to connect to the hSensor platform hardware. 

 

 
<<insert Fig18>> 

 

 

9) The following screen shows up.  

 
<<insert Fig19>> 

 



 

  
<H2>hSensor Interaction:  

The hSensor platform sensors are listed when the device is connected. Temperature, 

accelerometer and pressure are shown. Heart-rate information can be shown from the 

MAX30003 ECG device. ECG leads must be connected to the hSensor platform in order to 

show a correct reading. After connecting the leads, click the Start button on the screen. The 

platform starts sampling ECG R-to-R information and displays the resulting heart rate on the 

screen. 

 

<H2>Disconnecting  

The hSensor device may be disconnected by pressing the DISCONNECT button found at the 

top of the screen.  

 

<H1>All Design Files 
Download All Design Files <<hyperlink to filename: RD100V01_00.zip>> 

<H2>Hardware Files 
<H3> 
Schematic <MAXREFDES100_SCH_RA.pdf> 
Bill of Material (BOM) <MAXREFDES100_BOM_RA.pdf>  
PCB Layout <MAXREFDES100_LAYOUT_RA.pdf> 
Fab Package <MAXREFDES100_FAB_PACKAGE_RA.ZIP> 
PCB CAD <MAXREFDES100_CAD_RA.ZIP> 

<H2>Software Files 
<H3> 
PC GUI Program <MAXREFDES100SWxx.zip> 
PC Serial Driver < MAXREFDES100SerialDriverxx.zip> 
Android App <MAXREFDES100_Android.zip>  

 
<H1>Buy Reference Design 

Trademarks 
1-Wire is a registered trademark of Maxim Integrated Products, Inc. 

Android is a registered trademark of Google Inc. 

ARM is a registered trademark and registered service mark and Cortex is a registered 

trademark of ARM Limited. 



The Bluetooth word mark and logos are registered trademarks owned by Bluetooth SIG, 

Inc. and any use of such marks by Maxim is under license. 

QSPI is a trademark of Motorola, Inc. 

Windows is a registered trademark and registered service mark of Microsoft Corporation. 

 

 


